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Disclaimer

1.1 AVEVA does not warrant that the use of the AVEVA software will be uninterrupted, error-free or free from viruses.

AVEVA shall not be liable for: loss of profits; loss of business; depletion of goodwill and/or similar losses; loss of
anticipated savings; loss of goods; loss of contract; loss of use; loss or corruption of data or information; any special,
indirect, consequential or pure economic loss, costs, damages, charges or expenses which may be suffered by the
user, including any loss suffered by the user resulting from the inaccuracy or invalidity of any data created by the
AVEVA software, irrespective of whether such losses are suffered directly or indirectly, or arise in contract, tort
(including negligence) or otherwise.

1.2

1.3 AVEVA's total liability in contract, tort (including negligence), or otherwise, arising in connection with the
performance of the AVEVA software shall be limited to 100% of the licence fees paid in the year in which the user's
claim is brought.

1.4 Clauses 1.1 to 1.3 shall apply to the fullest extent permissible at law.

In the event of any conflict between the above clauses and the analogous clauses in the software licence under
which the AVEVA software was purchased, the clauses in the software licence shall take precedence.

1.5

Copyright

Copyright and all other intellectual property rights in this manual and the associated software, and every part of it
(including source code, object code, any data contained in it, the manual and any other documentation supplied
with it) belongs to, or is validly licensed by, AVEVA Solutions Limited or its subsidiaries.

All rights are reserved to AVEVA Solutions Limited and its subsidiaries. The information contained in this document is
commercially sensitive, and shall not be copied, reproduced, stored in a retrieval system, or transmitted without the
prior written permission of AVEVA Solutions Limited. Where such permission is granted, it expressly requires that
this copyright notice, and the above disclaimer, is prominently displayed at the beginning of every copy that is made.

The manual and associated documentation may not be adapted, reproduced, or copied, in any material or electronic
form, without the prior written permission of AVEVA Solutions Limited. The user may not reverse engineer,
decompile, copy, or adapt the software. Neither the whole, nor part of the software described in this publication
may be incorporated into any third-party software, product, machine, or system without the prior written
permission of AVEVA Solutions Limited, save as permitted by law. Any such unauthorised action is strictly prohibited,
and may give rise to civil liabilities and criminal prosecution.

The AVEVA software described in this guide is to be installed and operated strictly in accordance with the terms and
conditions of the respective software licences, and in accordance with the relevant User Documentation.
Unauthorised or unlicensed use of the software is strictly prohibited.

Copyright 2003 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved. AVEVA shall not be
liable for any breach or infringement of a third party's intellectual property rights where such breach results from a
user's modification of the AVEVA software or associated documentation.

AVEVA Solutions Limited, High Cross, Madingley Road, Cambridge, CB3 0HB, United Kingdom.

Trademarks

AVEVA and Tribon are registered trademarks of AVEVA Solutions Limited or its subsidiaries.  Unauthorised use of the
AVEVA or Tribon trademarks is strictly forbidden.

AVEVA product/software names are trademarks or registered trademarks of AVEVA Solutions Limited or its
subsidiaries, registered in the UK, Europe and other countries (worldwide).

The copyright, trademark rights, or other intellectual property rights in any other product or software, its name or
logo belongs to its respective owner.
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CHAPTER 1 - Preface

LFM Gateway Mode Data Preparation and Registration Help Guide

Preface1

This chapter gives basic information about this guide, training and support.

About this Guide1.1

This guide describes how to register scan data in the Gateway mode.

Audience1.2

This set of documentation is aimed at new users and covers the use of AVEVA

LFM Server: Gateway Mode, Server Mode, its associated CAD links and

production of AVEVA LFM related resources such as HyperBubble data, Solid

Pointcloud data and AVEVA LFM NetView projects. The contents cover operations

for both Engineering Users and Project Administrators. It is assumed that the user

already has AVEVA LFM Server installed and has the appropriate license features

available.
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Related Documents1.3

Other related documents include:

· AVEVA LFM Server - Autodesk AutoCAD Interface 

Also covers AutoCAD MEP, CADWorx and Bentley AutoPLANT

· AVEVA LFM Server – Autodesk Navisworks Interface 

· AVEVA LFM Server – Autodesk Revit Interface 

· AVEVA LFM Server - Aveva PDMS CAD Interface 

· AVEVA LFM Server - Aveva Review CAD Interface 

· AVEVA LFM Server - Bentley MicroStation CAD Interface 

Also covers Bentley ConstructSim

· AVEVA LFM Server - Intergraph PDS CAD Interface 

· AVEVA LFM Server - Intergraph SmartPlant 3D CAD Interface 

· AVEVA LFM Server - Intergraph SmartPlant Review CAD Interface 

· AVEVA LFM Server - COMOS Walkinside CAD Interface 

· AVEVA LFM Server - Quick Start Guide 

The AVEVA LFM Server Quick Start Guide is not intended to cover every

aspect of this package, but should provide designers with a 3D CAD

background a quick introduction to common features and typical project

requirements.

· AVEVA LFM NetView Project Publishing Guide 

This guide covers the creation and deployment of an AVEVA LFM NetView

project from the point that the AVEVA LFM Server dataset (.lfd) is

available up until, and including the point where the VHD is created.

· HyperBubble and Solid Point Cloud Creation and Use Guide 

This guide covers everything related to the new HyperBubble feature

including pre-requisites, publishing and use.

Note: These documents can be accessed by opening the file browser and

browsing to the location where AVEVA LFM Server is installed. By default, they

are available at the following location:

C:\Program Files\LFM Software\LFM\helpfiles
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Technical Support1.4

Online support and more information about AVEVA LFM should be requested

through lfm.support@aveva.com.

To aid fault diagnosis, please include the following information when contacting

AVEVA LFM Support:

· Urgency

· Full version number of AVEVA LFM Server

· Information about any CAD package being connected to (including full

version number)

· AVEVA LFM Server log files. To obtain these, go to the File > Home tab

and click the Copy Log Files button. This copies a series of 5 text files to

the location of your choice. These will be called lfmServerRunA.log –

lfmServerRunE.log. Please send all 5 files.

AVEVA LFM Upgrades

Upgrades can be downloaded from the AVEVA LFM Software website from

https://www.aveva.com/en/Services_and_Support/AVEVA_Product_Support/#LFM

-Support.

Product and Training Information1.5

For general information and commercial enquiries, please contact

lfm.info@aveva.com.

For information about product training courses, see the Product Training section of

AVEVA's website (http://www.aveva.com/training), or contact the nearest AVEVA

Regional Support Centre (http://support.aveva.com/support).

https://www.aveva.com/en/Services_and_Support/AVEVA_Product_Support/#LFM-Support
https://www.aveva.com/en/Services_and_Support/AVEVA_Product_Support/#LFM-Support
http://www.aveva.com/training
http://support.aveva.com/support
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Project Setup and Data Conversion2

Data conversion is integrated into the AVEVA LFM Server Gateway Mode

interface. After the scans have been added to the project the conversion

seamlessly starts in the background. Scans are processed in parallel according to

the amount of memory available on the machine (1 conversion per 4GB RAM).

After a scan has finished converting, it can be used instantly. There is no need to

wait for the other scans to finish converting.

Scan formats that can be used in AVEVA LFM Server Gateway Mode are listed

below:

· .zfs

· .zfc

· .ptx

· .ptz

· .pts (points only)

· .fls

· .fws

· .3dd

· .rxp

· .tzf

· .rsp

· .prj

· .las (points only)

· .laz (points only)

· .dp (points only)

· .e57 (structured and unstructured)

· .mvx (Mantis)

· .cl3 (Topcon)

AVEVA LFM Server Gateway Mode supports the addition of colour to laser scan

data in .jpg, .png or .nctri (iSTAR) formats, and the import of standalone

panoramic pictures in .jpg and .png formats.

Note: You must run the application in the Advanced mode to be able to import

Mantis scan data.
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Note: For .prj files, the appropriate hardware license is required on the scanner to

be able to import these files into third party software, such as AVEVA LFM Server

Gateway Mode. Please contact your local Leica representative for more

information.

Workflow2.1

The workflow for data conversion is described in the following steps:

1. Start AVEVA LFM Server by double-clicking on the desktop shortcut.

2. After the interface has loaded, check if you are in Gateway mode. The

current mode is shown at the top-right corner of the interface. If you are

in Server mode, switch to Gateway mode by clicking the drop-down

arrow at the top-right corner of the AVEVA LFM Server interface and

select Gateway.

3. When in Gateway mode, click File and select New Project. This opens

a browser window.

4. Specify the project location and name, then click Save.

Note: For colour scans, please ensure the colour panoramic .jpg or .png

files are in the same location as the source scans before proceeding

with the steps below. The .jpg or .png must be named the same as the

scan name with “_color” at the end (For example, Scan1_color.jpg).
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5. In the Registration panel, right-click the project and select Import to

this project. This opens a browser.

6. Select the scans to be added and click Open.

7. Alternatively, select the scans to be added in a Windows Explorer

window and drag and drop them on to the project node. This brings up

the Conversion options dialogue shown below:

Note:  If you are importing partial scans, select only the parent full

scans. If the partial scans are in the same folder as the parent full

scans, the partial scans are automatically imported by AVEVA LFM

Server.

8. Select the desired location for the converted scans. By default this will

be the same folder as the .lfm file location.

9. To add colour to scans from an iSTAR camera (through an .nctri file),

select Colourise scans from iStar images.
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10. Then click Choose colourisation files. The dialogue shown below

appears.

11. Click on each scan to select the corresponding .nctri file. Then click OK

when done.

12. Click Convert on the Conversion Options dialogue after the appropriate

options have been set. The scans automatically start to convert. After a

scan has finished converting, its status is shown as Complete.

The progress of the conversion is displayed at the bottom-right corner of

the Gateway interface.

 Note:  If the data being imported is unstructured, .ptx data, enable the Import As
Unstructured box. Ptx files should be formatted as shown below:
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Importing LAS (.las/.laz) Data2.2

LAS is a commonly used data format to deliver Lidar data captured using

techniques such as airborne or mobile data capture systems. As these data

capture mechanisms are used during the capture of large geographic areas, it is

normal to capture the data in a geo-referenced form. This geo-referenced

information can either be embedded within the LAS file as metadata or added

during the import process within the AVEVA LFM Server Gateway Mode interface.

AVEVA LFM Server Gateway Mode accepts both geo-referenced and non-

georeferenced LAS data.

For geo-referenced data in a specified map projection, to avoid any issues with

multiple LAS scans in different projects when the LAS data is loaded into AVEVA

LFM Server Gateway Mode, the data will be re-projected into an Earth Centred

Earth Fixed (ECEF) Cartesian co-ordinate system.

Earth Centred Earth Fixed (ECEF)2.2.1

Rather than using a projection system where points in the scan data are projected

onto a flat surface for the production of maps, using ECEF co-ordinates allows the

data to be mapped on to a spherical body which is representative of the Earth’s

surface. This allows AVEVA LFM Server users to seamlessly use multiple LAS

scans within a single project or dataset.

Import Process2.2.2

The import process is as described below:

1. In the Registration panel, right-click the project and select Import to

this project. This opens a browser.

2. Select the LAS files to be added and click Open.

3. Alternatively, select the LAS files to be added in a Windows Explorer

window and drag and drop them onto the project node.
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Having selected the data to be imported, the Conversion Options dialog is

displayed. This enables the user to interrogate the metadata for each file and set

the appropriate source projection system if needed.

All the scans listed have one of the following icons that signify the registration

type:

· Blue - Georegistered

· Green - Plant space

· Red - Unregistered

The following image displays the different types of icons for each registration type:

Note: Before loading the scan data, it must be either geo-registered or in plant

space, and must be of the same registration type.
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Metadata2.2.3

Selecting one of the LAS files within the interface displays the metadata stored

within that file in the lower part of the dialog, if it is available. This metadata is

optional and will be completed by the service provider that generated the data.

When multiple files are selected, the metadata interface displays the list of all the

files selected and the number of files selected. Displaying the number of files

selected helps ensure the number of files in the interface is as expected, as when

selecting thousands of source files it can be difficult to verify if all the files are

selected.

The registration type within this section of the dialog provides the projection

information within the metadata if specified. If you do not set the projection

information, the field will be missing from the interface and it will be necessary to

set this directly for the data using the Modify Georegistration button. The

provider of the data will be able to supply details of the geo-registration codes to

use.
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The geo-registration code (to specify the projection of geographic coordinate

system) is based on the IOGP EPSG Geodetic Parameter Dataset. This is a

collection of definitions of coordinate reference systems and coordinate

transformations which may be global, regional, national or local in application (see

http://www.epsg.org/). The list of EPSG codes is extensive, there are additional

codes such as the ESRI spatial reference codes. Whilst these codes cannot be

directly entered through the .las import interface, it is possible to enter the Proj.4

definitions for a spatial reference code. In this case select the Proj.4 toggle within

the interface (highlighted below) and enter the code. A good source of spatial

reference codes is http://spatialreference.org/.

You can define the Plant system in the Modify Georegistration dialog by

specifying the horizontal and vertical units of measure.

Note: If the vertical unit of measure is not specified, it defaults to the horizontal

unit of measure.

Number of Points in the File2.2.4

The metadata interface displays the number of points reported in the header block

of the source data. It cross-references this with an estimated calculation of the

number of points in the file and any difference is reported.

It should be noted that with compressed LAZ files the estimating of the number of

points can be imprecise and therefore may be different. The number of points in

the file is needed to allow random access to the data for deriving data such as the

classification of return points.

http://www.epsg.org/
http://spatialreference.org/
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Classification of Data2.2.5

LAS data points not only have a position, intensity and RGB value, they also have

a classification value. When a single LAS file is selected in the interface and the

metadata for the file is displayed, at the end of the metadata interface is a

summary of the classification of the points. This table is derived by taking a

random sample of points from within the file and reading classification values.

There is a small overhead in obtaining this information so the interface may take a

second or two to update.

Error Messages2.2.6

In the event where there is an issue reading the LAS data, this will be reported in

the metadata interface.



Page 17 Release 5.3

© Copyright 2003 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.

 

CHAPTER 2 - Project Setup and Data Conversion

LFM Gateway Mode Data Preparation and Registration Help Guide

Conversion Options2.3

Project conversion options can be set in File > Options > Gateway as shown

below:

These are global preferences and will be applied to all scans added to the project.

Range Clipping

To aid the modelling and viewing process, data which is considered too near or too

far away to be of interest can be clipped using the near and far range clipping.

Points that have been clipped in this way are not displayed at all in the 3D window.

The near and far clipping values can be adjusted directly by double-clicking on the

desired option and typing a new value into the appropriate text fields or clicking on

the up and down arrows.

The minimum and maximum range values will be set to the optimum values

relative to the scanner type.
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Intensity Clipping

To aid the modelling and viewing process, it is possible to clip intensity data which

is considered too bright or too dull to be of interest. Points that have been clipped

in this way are not displayed at all in the 3D window. The near and far clipping

values can be adjusted directly by double-clicking on the desired option and typing

a new value into the appropriate text fields or clicking on the up and down arrows.

The minimum and maximum intensity values will be set to the optimum values

relative to the scanner type.

Mask Pixels

This function is designed to significantly reduce the splatter, or spray effect which

arises when the laser scanner's beam switches from one object to another. It is

able to locate lone pixels or pixels which have too few neighbours.

All non-boundary pixels have eight surrounding neighbours and so, in normal

circumstances, a pixel would expect to find its nearest neighbours at similar

ranges.

The options are as follows:

· Apply Mixed Pixel - Pixels that are at different ranges are flagged as

being mixed pixels and are then masked out of the image. Enable this field

to apply mixed pixel.

· Number of Neighbours (ranges from 1-8) - This value sets a threshold for

required neighbouring points. If the threshold value is not reached, a pixel

is deemed noisy and masked out.

The recommended value is 2.

· Threshold (degrees) - As an image is scanned by the algorithm, each

pixel in turn becomes the centre pixel with eight neighbours. Eight lines are

then formed from the centre pixel to its neighbours.

The Rejection Angle is the angle formed between the view line (line

between the centre pixel and the origin) and each of the eight pixel lines.

The recommended value is 5°.

Data masked out by this function will not be visible in 3D Modelling Windows, but

will be coloured green in 2D Image Windows. The effect of the mask mixed pixels

function is entirely reversible by modifying the conversion options and reconverting

the scans.

In common with all these data points functions, the data is never actually deleted

or modified, but is masked out and so easily restored.
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Minimum Field of View

The minimum azimuthal and elevation required for a scan to be processed. Scans

not fitting this criteria will not be processed. This is often useful for bundled ptx

scans which contain very small partials that are not of much value in isolation.

Dead Angle

This enables the user to change the dead region cut-off zone in the base of the

scan. The default settings remove the points in the area directly underneath the

scanner, where the scanner may see its own tripod. This may be adjusted if a

slightly higher viewing angle is required. To change, double-click the desired

option and type the new value into the appropriate text fields or click the up and

down arrows.

Individual Scan Settings

On review of the converted scans, several individual scans may require different

conversion settings, for example a longer range setting.

To do this:

1. In the Registration panel, create a new group by right-clicking the

project and selecting the New > Register Group.

2. Rename the group by right-clicking on the group and selecting Rename.

3. Type in the desired name and press Enter.
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The group conversion options can be edited at the bottom of the properties

window as shown below. Scans can be added to a group by clicking and dragging

the scans onto the group node.
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Importing Panoramic Photos2.4

AVEVA LFM Server Gateway Mode supports the import of panoramic photos in

.jpg, .png or iSTAR (.nctri) formats.

To import panoramic photos:

1. In the Registration panel, right-click the project and select Import to

this project. This opens a browser.

2. Select the panoramic photos to be added and click Open.

3. Alternatively, select the panoramic photos to be added in a Windows

Explorer window and drag and drop them on to the project node. The

window shown below appears:

4. Click Browse and select the location for the output files, then click

Select Folder. A preview of the panoramic photo will be shown in the

lower part of the dialog.

5. Click Convert to begin the import process.

After the import process has completed the panoramic photo will be available in

the Registration panel. It is also represented in the 3D view by a 3D shape. The

.jpg and .png files are represented by a sphere, .nctri files are represented by an

iSTAR camera shaped object.
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To view the panoramic photo follow the steps below:

1. Right-click the name and select Show Panoramic Image.

2. Alternatively, you can drag and drop the panoramic photo node from the

Registration panel into the 3D view to load the panoramic photo OR

You can right-click the panoramic photo representation in the 3D view

and select Show Panoramic Image. The panoramic photo is displayed

as shown below:

3. Click and drag to move the view around and use the mouse wheel to

zoom in and out, just like a BubbleView. As there is no 3D scan data

linked to a panoramic photo, functionality is limited to viewing only.

To close the panoramic image, hover over the top-right corner of the 3D window

and click the Panoramic Image icon. Then click Close Panoramic Image.

Panoramic photos are positioned at 0,0,0 by default. However, they can be

repositioned by either entering coordinates or by visually positioning them in the

3D window.
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Entering Coordinates

To change the position of a panoramic photo by entering coordinates, follow the

steps below:

1. In the Registration panel, select the panoramic photo to be positioned.

At the bottom of the Registration panel, you will see the Attributes

window which displays information about the panoramic photo, including

the position.

To edit the position, follow the steps below:

1. Click to select the relevant x/y/z field, and then double-click to make the

field editable.

2. Enter the desired coordinate and press Enter.

3. Repeat this for the other positional fields.
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Visually Positioning

To change the position of a panoramic photo by visually positioning it, follow the

steps below:

1. In the Registration panel, right-click the panoramic photo and select

Manipulate.

2. In the 3D window the panoramic photo 3D representation is shown with

a red/green/blue coordinate frame around it.

3. Click and drag the relevant arrows to move the panoramic photo to the

appropriate position.

4. Right-click one of the arrows to accept the new position or press Esc to

cancel the manipulation and return the item to its original position.

Any panoramic photos present in the project at the point of dataset (.lfd)

generation is carried through to the AVEVA LFM Server dataset for viewing by

engineering users.
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Registration Using a Full Survey3

This section provides details on registering scans using a full survey.

Adding the Survey3.1

To add the survey, follow the steps below:

1. In the Registration panel, right-click the project node and select Import

to this project. This brings up a browser.

2. Select the survey file to be added and click Open. The supported survey

formats are .crd and .k.

These are effectively composite files, comprising consolidated data from all field

survey stations. Users may adapt unsupported formats to comply with the

standard AVEVA LFM files, please review the examples listed below:

Sample format of a .crd (coordinate) file.

T001 0.000 0.000 0.000

T002 13.000 11.000 16.000

T003 11.250 10.019 32.233

T004 19.845 96.100 34.892

T005 67.228 56.872 34.766

Target name, X, Y & Z stored in metres.

Note: File can be space or tab delimited

Sample format of a K (Kramer) file.

T001 7 0.000 0.000 0.000

T002 7 13.000 11.000 16.000

T003 7 11.250 10.019 32.233

T004 7 19.845 96.100 34.892

T005 7 67.228 56.872 34.766

Note:  There should be six blank lines at the top of the file. The first figures should

be the target identifier, the second column should contain a figure seven (AVEVA

LFM will ignore), with the remaining X – Y – Z readings. (Easting, Northing &

Elevation) All numbers recorded are interpreted as metres. This is to copy the

format of the Kramer survey adjustment package.
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Identifying Targets3.2

To identify targets, follow the steps below:

1. After the survey has been added, right-click the scan to be registered

and select Show BubbleView OR alternatively drag and drop the scan

node into the 3D window. The BubbleView loads for the selected scan

and the Tools toolbar becomes available at the top of the interface.

2. Load the 3D points belonging to a scan by right-clicking on the scan and

selecting Load Points.

3. Navigate round the BubbleView to the first target to be picked. Click the

Pick Targets button from the Tools menu and select the target centre

with a left mouse click. This brings up a small magnified target

identification area where the target centre can be picked by a left mouse

click.

 

4. Alternatively, targets can also be picked in the 3D window. This is useful

for registering mobile scan data such as .pts or .dp, which will not

produce a BubbleView.
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5. After picking the target centre, the Identify Target window appears. Type

in the name of the target and click OK.

  

Note:  The target name should exactly match the survey, for example if the target

in the survey is referred to as *rr127, the name entered must be *rr127. Note also

that this is case sensitive.

The user may apply a group target prefix if all targets have the same prefix. To do

this, follow the steps below:

1. In the attributes window, select the appropriate group and fill in the

Group target prefix option as shown below. This automatically enters

the specified prefix in the Identify Target window when selecting targets.

Identified targets appear as yellow crosses in the BubbleView and as

black target icons under the scan node in the Registration tab. If the

target number entered cannot be found in the survey, a red exclamation

mark is shown over the black target icon in the Registration tab.

2. Repeat this process for other targets visible in the scan.

Target Predication

When two targets have been identified, other targets in the scan will begin to

appear through the target prediction system. These appear as green crosses in

the BubbleView and green target icons under the scan node in the Registration

tab.

Select a predicted target by double-clicking on it under the scan node in the

Registration tab. This will centre the BubbleView and target identification zoom

window on the predicted target.

Note:  Targets are sorted by ascending range so it is often best to start with the

target at the top of the list.
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There are four options at this stage:

· Click the centre of the target to change the position and name of the

predicted target and move on to the next prediction.

· Right-click the centre of the target to change only the position. This

accepts the predicted target name and moves on to the next prediction.

· Click the  button in the target identification zoom window. This accepts

both the position and the name of the predicted target and moves on to the

next prediction. The “Y” button on the keyboard will also perform the same

function.

· Click the  button in the target identification zoom window. This does not

accept the predicted target and move on to the next prediction. This is

used when the target cannot actually be seen (for example, if it is on the

other side of a wall or if it is too far away). The “N” button on the keyboard

also performs the same function.

 Note:  If a picked target has a negative effect on the scan registration (such as by

causing a traffic light to turn red) then the target zoom window remains on that

target and will not proceed to the next prediction. This is an alert to the user that

the accuracy of the registration has been compromised and the user should

address the error before moving on.

Target Accuracy3.3

After a target is registered, feedback on the accuracy is displayed at the side of

the target in the Registration tab. This feedback takes the form of two traffic light

icons. This is a rapid way of interpreting registration accuracy. The coloured icons

enable the user to visually skim through the results, focusing quickly on the targets

causing concern. These appear as amber or red in the components browser.

The diamond shape refers to the inter distance between the selected target and its

neighbours within the scan. These inter distances are compared against the

corresponding inter distances in the survey.
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The circle shape refers to the distance between the picked target in the scan and

the corresponding target position in the survey post registration. Generally, there

should be more than 5 target correspondences in every scan to ensure accurate

registration.

The traffic lights will be red, amber or green. The thresholds for these colours can

be changed in the File > Options > Gateway tab.

Anything between 0 and the amber threshold will be green. Anything between the

amber threshold and the red threshold will be amber. Anything above the red

threshold will be red.

The recommended values are amber = 0.003m and red = 0.006m. If the threshold

is altered during registration, an automatic update of target accuracy is carried out

respective to the new settings.

As soon as two targets have been selected within a scan, provided a survey is

attached to model, the system shows the accuracy of the target fitting. As this

process is ongoing as targets are selected, poorly fitted targets will be highlighted

instantly, allowing an immediate refit. This saves a great deal of time later on

identifying rouge targets. Numerical error readings are provided in the Attributes

window for confirmation.
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Improving the Accuracy of Poorly Fitting Targets

The example shown below demonstrates poor accuracy on target 091:

Inaccurately fitted targets such as this can be reviewed by right-clicking on the

target in the Registration panel and selecting Show Context. This shows the

graphical representation of the pick against the 3D point cloud. 

Targets can be re-picked by clicking on the centre of the target in the target

identification window within the BubbleView, entering the target name and clicking

OK. This will present a warning as shown below that the target has already been

picked. Click Yes to accept or No to cancel.

Targets can also be temporarily disregarded by right-clicking on the target in the

Registration tab and selecting Do not use for Registration. Targets that have the

Do not use for Registration feature applied are shown with a red strikethrough

as shown below on target 130.
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The image shown below demonstrates the scan registration after the Do not use

for Registration feature has been applied to a target. The registration of the scan

is now good. This feature can be removed if necessary by right-clicking again on

the target and selecting Use for Registration.

When the registration is complete you can then move on to the next scan. This

should be repeated for all scans in the project.

Note:  Target sizes can be changed in the File > Options > Gateway tab as

shown below:

After the Registration is complete, it is good practice to update the scan headers.

This stores the position, rotation and targets in the .zfc file itself rather than just

the project file. This means that registered scans can be added to another project

still in the correct position. This is also useful for service providers delivering to

users using AVEVA LFM Modeller or AVEVA Laser Modeller.

Note: The .zfc files generated using AVEVA LFM Server 4.4.2 version support an

extended range and hence cannot be read by earlier versions of AVEVA LFM

Server and AVEVA Laser Modeller/AVEVA LFM Modeller.

To update the scan headers, right-click the group node and select Scan Headers

> Update ZFC Headers.

To update the ZFS scan headers, right-click the group node and select Scan

Headers > Update ZFS Headers. This preserves the positions of the aligned

scans when used in a different project. You can then use the ZFS scan files to

produce different outputs, such as ReCap, Cloudworx, TruView and so on, without

having to re-register the scans in another registration toolset.
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Registration Using a Partial/No Survey with Targets4

If site access is limited there may only be a partial survey or no survey at all. If

targets have been placed in the scanned scene, these can be registered using a

process called Bundle Adjustment. If a partial survey is used, the scans will be

registered to the site coordinates as specified in the partial survey. If no survey is

used, the scans will be registered locally. 

Bundle adjustment is an iterative process which calculates the mean position of a

target from each target pick over multiple scans.

Before starting registration using Bundle Adjustment, please ensure the Perform

Bundle Adjust option in the File > Options > Gateway tab is enabled.

Adding the Survey4.1

If a partial survey is available, add the survey by following the steps below:

1. In the Registration panel, right-click the project node and select Import

to this group. This brings up a browser.

2. Select the survey file to be added and click Open. Supported survey

formats are .crd and .k.

These are effectively composite files, comprising consolidated data from all field

survey stations.
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Users may adapt unsupported formats to comply with the standard AVEVA LFM

files, please review the examples listed below.

Sample format of a .crd (coordinate) file.

T001 0.000 0.000 0.000

T002 13.000 11.000 16.000

T003 11.250 10.019 32.233

T004 19.845 96.100 34.892

T005 67.228 56.872 34.766

Target name, X, Y & Z stored in metres.

Note:  File can be space or tab delimited.

Sample format of a K (Kramer) file.

T001 7 0.000 0.000 0.000

T002 7 13.000 11.000 16.000

T003 7 11.250 10.019 32.233

T004 7 19.845 96.100 34.892

T005 7 67.228 56.872 34.766

Note:  There should be six blank lines at the top of the file. The first figures should

be the target identifier, the second column should contain a figure seven (AVEVA

LFM will ignore), with the remaining X – Y – Z readings. (Easting, Northing &

Elevation) All numbers recorded will be interpreted as metres. This is to copy the

format of the Kramer survey adjustment package.

Identifying Targets4.2

To identify targets, follow the steps below:

1. After the survey has been added, right-click the scan to be registered

and select Show BubbleView OR alternatively drag and drop the scan

node into the 3D window. The BubbleView will load for the selected scan

and the Tools toolbar will become available at the top of the interface.

2. Load the 3D points belonging to a scan by right-clicking on the scan and

selecting Load Points.
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3. Navigate round the BubbleView to the first target to be picked. Click the

Pick Targets button from the Tools menu and select the target centre

with a left mouse click. This brings up a small magnified target

identification area where the target centre can be picked by a left mouse

click.

 

4. Alternatively, targets can also be picked in the 3D window. This is useful

for registering mobile scan data (such as .pts or .dp) which will not

produce a BubbleView.

5. After picking the target centre the Identify Target window is displayed.

Type in the name of the target and click OK. Identified targets appear as

yellow crosses in the BubbleView and as black target icons under the

scan node in the Registration tab.

6. Repeat this process for other targets visible in the scan.

To register the scans using the currently identified targets, right-click the group

node and select Register All.

Note:  This function only applies to the parent group, it does not apply to any child

groups.

Target Prediction

Any targets identified that do not have a corresponding survey point will be added

to the bundle node. The bundle acts as an artificial survey which is made up by the

targets picked in previous scans. When the bundle is built up enough to be used,

AVEVA LFM’s target prediction system will become available as detailed below.

After two targets have been identified other targets in the scan will begin to appear

through the target prediction system. These will appear as green crosses in the

BubbleView window and green target icons under the scan node in the

Registration tab.
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Select a predicted target by double-clicking on it under the scan node in the

Registration tab. This will centre the BubbleView and target identification zoom

window on the predicted target.

Note:  Targets are sorted by ascending range so it is often best to start with the

target at the top of the list.

There are four options at this stage:

· Left-click the centre of the target to change the position and name of the

predicted target and move on to the next prediction.

· Right-click the centre of the target to change only the position. This

accepts the predicted target name and moves on to the next prediction.

· Click the  button in the target identification zoom window. This accepts

both the position and the name of the predicted target and moves on to the

next prediction. The “Y” button on the keyboard also performs the same

function.

· Click the  button in the target identification zoom window. This will not

accept the predicted target and move on to the next prediction. This is

used when the target cannot actually be seen (for example, if it is on the

other side of a wall or if it is too far away). The N button on the keyboard

will also perform the same function.

Note:  If a picked target has a negative effect on the scan registration (such as by

causing one or more traffic lights to turn red) then the target zoom window will

remain on that target and will not proceed to the next prediction. This is an alert to

the user that the accuracy of the scan has been compromised and the user should

investigate further before moving on.

If scans are registered locally to each other, it is possible that the “master” scan

(which the others are registered to) will be classed as unregistered. As

unregistered scans are not included in the AVEVA LFM Server dataset generation,

you may wish to class the master scan as registered. To do so, right-click the

master scan and select Force to Registered.

Target Accuracy4.3

After a target is registered, feedback on the accuracy will be displayed at the side

of the target in the Registration tab. This feedback takes the form of two traffic

light icons. This is a rapid way of interpreting registration accuracy. The coloured

icons enable the user to visually skim through the results, focusing quickly on the

targets causing concern. These will appear as amber or red in the components

browser.
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The diamond shape refers to the inter distance between the selected target and its

neighbours within the scan. These inter distances are compared against the

corresponding inter distances in the survey or bundle as appropriate.

The circle shape refers to the distance between the picked target in the scan and

the corresponding target position in the survey or bundle, post registration.

Generally, there should be more than 5 target correspondences in every scan to

ensure accurate registration.

The traffic lights will be red, amber or green. The thresholds for these colours can

be changed in the File > Options > Gateway tab.

Anything between 0 and the amber threshold will be green. Anything between the

amber threshold and the red threshold will be amber. Anything above the red

threshold will be red.

The recommended values are amber = 0.003m and red = 0.006m.

If the threshold is altered during registration, an automatic update of target

accuracy is carried out respective to the new settings.

Improving the Accuracy of Poorly Fitting Targets

The example shown below demonstrates poor accuracy on target 091.
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Inaccurately fitted targets such as this can be reviewed by right-clicking the target

in the Registration tab and selecting Show Context. This shows the graphical

representation of the pick against the 3D point cloud.

Targets can be re-picked by clicking the centre of the target in the target

identification window within the BubbleView, entering the target name and clicking

OK. This presents a warning as shown below that the target has already been

picked. Click Yes to accept or No to cancel.

Targets can also be temporarily disregarded by right-clicking the target in the

Registration tab and selecting Do not use for Registration. Targets that have

the Do not use for Registration feature applied are shown with a red

strikethrough as shown below:

The image shown left demonstrates the scan registration after the Do not use for

Registration feature has been applied to target 130. The registration of the scan

is now good. This feature can be removed if necessary by right-clicking again on

the target and selecting Use for Registration.
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After the registration is complete right-click the scan and select Register All. You

can then move on to the next scan. This should be repeated for all scans in the

project.

Note: Target sizes can be changed in the File > Options > Gateway tab as

shown below:

After the Registration is complete it is good practice to update the scan headers.

This stores the position, rotation and targets in the .zfc file itself rather than just

the project file. This means that registered scans can be added to another project

still in the correct position. This is also useful for providers delivering to users

using AVEVA LFM Modeller or AVEVA Laser Modeller.

To update the scan headers right-click the group node and select Scan Headers >

Update ZFC Headers.

To update the ZFS scan headers, right-click the group node and select Scan

Headers > Update ZFS Headers. This preserves the positions of the aligned

scans when used in a different project. You can then use the ZFS scan files to

produce different outputs, such as ReCap, Cloudworx, TruView and so on, without

having to re-register the scans in another registration toolset.
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Registration Using No Survey without Targets
(Inter-Cloud Registration)

5

If site access is limited, there may be no survey and no targets placed throughout

the scanned scene. In these circumstances, scans can still be registered by

identifying common points between each of the scan locations. If used in

conjunction with scans registered to a survey, these scans can be registered to

site coordinates. If there are no scans that have been registered to a survey, the

scans will be registered locally.

Scans that will be registered through Inter-cloud registration should be placed in

their own subgroup. To do this: 

1. Right-click the project or parent group and select New > Register

Group.

2. Then click and drag the scans into the new group.

Identifying Common Points5.1

To identify common points, follow the steps below:

1. Right-click the scan to be registered and select Show BubbleView OR

alternatively drag and drop the scan node into the 3D window. The

BubbleView will load for the selected scan and the Tools toolbar will

become available at the top of the interface. Anything on a flat surface

can be used as a target as long as it can be seen in both scans being

registered together. Corners of signs or small marks on walls

traditionally make good targets.

2. Load the 3D points belonging to a scan by right-clicking on the scan and

selecting Load Points.

3. Navigate round the BubbleView to the first point to be picked.
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4. Click the Pick Targets button from the BubbleView toolbar and select

the point with a left mouse click. This brings up a small magnified target

identification area.

 

5. Alternatively, targets can also be picked in the 3D window. This is useful

for registering mobile scan data (such as .pts or .dp) which will not

produce a BubbleView.

6. After picking the target, the Identify Target window appears. Type in the

name of the target (example, T1) and click OK. Identified targets appear

as yellow crosses in the BubbleView and as black target icons under the

scan node in the Registration tab.

7. Repeat this process for other targets in the scan and also the same

targets in the other scans to be registered.

8. After the targets have been identified in both scans, right-click the group

node and select Register All. Depending on the quality and accuracy of

the picked targets, this will place the scans in roughly the correct

position.

Note:  This function only applies to the parent group, it does not apply to

any child groups.
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Visual Scan Manipulation5.2

The visual scan manipulation can be used as an alternative way to register scans

when there is no survey or targets.

1. The user may drag the scans close to the correct position through scan

manipulation. To do this, right-click the scan to be moved and select

Manipulate. This brings up an rbg modification frame positioned around

the scan centre as shown below:

2. Hover the mouse cursor over the axis you wish to move or rotate the

scan around.

3. Click and drag the scan to the desired position.

To escape this function and return the scan to its original position, press Esc. To

accept the new scan position, press Enter.

Completing the Registration5.3

After the scans are in roughly the correct position, AVEVA LFM can further

improve the registration using its in-built Inter-cloud registration function.

To do this: 

1. Right-click the group containing the scans to be registered and select

Cloud All. This brings up the Inter-cloud registration options window as

shown below:

Note: All the scans to be registered in this way must be loaded in both

the 3D and BubbleView first. 
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2. Set the following options:

· Maximum iterations: The number of times the Inter-cloud process

will run before completing unless it reaches the minimum threshold

option as described below. Increasing this value will lead to better

registration but will also take longer for the function to complete.

· Lock Distance: The distance AVEVA LFM looks for neighbouring

points within when calculating the registration. The value entered here

is the starting value. This value will decrease as the processing

progresses.

· Minimum Threshold: The error per point used that the Inter-cloud

process aims for. When the value is reached, the process will

complete unless the process reaches the maximum iterations value.

3. Press OK to start the Inter-cloud registration procedure. This may take

some time depending on the number of scans to be registered and the

initial placement of the scans.

During the Inter-cloud process, if the group node is selected in the Registration

tab, the attributes window will display information about the process as shown

below. This can be used to gauge how far along the process is.
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After the Inter-cloud process is complete, the attributes window will return to

displaying information about the group. There will be an additional entry at the

bottom of the attributes window called Last Cloud Registration Result.

After the Registration is complete, it is good practice to update the scan headers.

This stores the position, rotation and targets in the .zfc file itself rather than just

the project file. This means that registered scans can be added to another project

still in the correct position. This is also useful for providers delivering to users

using AVEVA LFM Modeller or AVEVA Laser Modeller.

To update the scan headers, right-click the group node and select Scan Headers

> Update ZFC Headers.

To update the ZFS scan headers, right-click the group node and select Scan

Headers > Update ZFS Headers. This preserves the positions of the aligned

scans when used in a different project. You can then use the ZFS scan files to

produce different outputs (such as ReCap, Cloudworx, TruView and so on),

without having to re-register the scans in another registration toolset.
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QA Reporting6

This section covers information on checking the registration quality for QA checks.

Registration Status Tab6.1

The Registration Status tab enables rapid interpretation of registration quality for

quick and easy QA checks. Registration can be checked at both a scan and target

level.

To add scans or targets to the Registration Status tab, follow the steps below:

1. Select the desired scans/targets in the Registration Management Panel.

2. After the desired scans/targets have been selected, right-click and

select Add to registration status tab OR drag and drop the

scans/targets on to the Registration Status tab.

3. The selected scans are displayed in the Registration Status window as

shown below:

Each scan will have an overall traffic light to indicate any problem targets.

· If a scan has one or more red traffic lights, the overall traffic light will be

red.

· If a scan has no red traffic lights but one or more amber traffic lights, the

overall traffic light will be amber.

· If the scan has no red or amber traffic lights the overall traffic light will be

green.

To see the targets identified in each scan, click the arrow on the left of the desired

scan name. This shows details of all the targets: their position, the error of the

overall target from the survey and the correspondence (bundle or survey).
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To close the Registration Status window, hover over the top-right corner of the

workspace window and click the Registration Status List icon, then click Close

Registration Status List.

To see the details of each individual pick for a target, click the arrow on the left of

the desired target. This shows details of all the individual picks that contribute to

that target: the scan name, the position, the error of the individual pick from the

survey and the error vectors of the individual pick from the survey.

If an individual pick is found to be bad (usually indicated by red traffic lights) the

user can do the following:

1. Right-click on that pick and select Do Not Use For Registration. This

removes that pick from the calculation of the target and scan and re-

registers the scan accordingly.

2. After a pick has been confirmed as not being required, the user can

right-click that target and select Delete.

3. To further refine the information available, the user can right-click

anywhere in the Registration Status window and apply one of the

following filter options:

· Nothing

· Red and amber traffic lights

· Red traffic lights

The following table describes the different fields for a given target:

Column Header Purpose

Name
Name/identifier of the object plus an indication of quality (traffic
lights)

Position The x, y, z position of the object

Error
The distance between the surveyed point and the average of all
related target picks

Error Vector The x, y, z error

Correspondence
An indication to show if the target relates to the Survey or the
Bundle 
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Exporting the Registration Information

The registration information can be exported to a .csv file which can become the

basis of a QA report for delivery to the client.

To do this, perform the following steps:

1. Right-click anywhere in the Registration Status window and select

Export Report.

2. Select the appropriate destination, name the file and click Save.

Network View6.2

The Network View enables the user to see a visual representation of the spread,

location and quality of the scans and targets.

The best way to visualise this is to switch to the ortho view. To do this, hover over

the top-right corner of the workspace window and click the Switch to 3D

perspective/3D orthographic icon.

This splits the screen into a side-on and top-down view. The user may alter the
proportions of this view by clicking and dragging (left/right) the dividing line as
shown below:

The user may turn off the 3D points by clicking the Points button in the
Visualisation menu.

Any scan/group/target that is loaded will have its network lines shown in the 3D.

Scans that have been marked as Do not use for Registration will be shown as

dotted lines. The colour of the lines will match the colour of the traffic lights for that

target.



Page 47 Release 5.3

© Copyright 2003 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.

 

CHAPTER 6 - QA Reporting

LFM Gateway Mode Data Preparation and Registration Help Guide

To keep the network lines for a particular scan on, right-click the scan in the

Registration tab and select Show lines from targets as shown below:

This keeps the network lines ON even if the scan is not selected in the

Registration tab.

To hide the lines again, right-click the scan and select Hide lines from targets.

Merging Projects6.3

It is sometimes desirable to split the registration of a large project across multiple

users. Each user should have their own project file containing their scans to be

registered. After each user has registered their own sub-project, a new master

project should be created.

1. The sub projects can then be imported to the master project by right-

clicking the project node in the master project and selecting Import to

this Project.

2. In the browser that appears, change the file type filter to LFM Project

Files (*.lfm).

3. Navigate to and select the first sub-project file in the file browser and

click Open. Repeat for all other sub-project files.
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